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Downloading Exercise Files

Exercise files can be downloaded from the Cheryl Price web site as follows:

1 In your web browser, type: www.cherylprice.co.nz

2 Press Enter on the keyboard to display the Cheryl Price website.

Click in the Product Search box and type the number of this unit

. Us 2791
3 standard, as shown at the right.

4 | Click on

5 Click on US 2791

Under the Exercise Files heading click on the underlined blue hyperlink, ie
6 Book Exercise Files — V7 Excel 2010 Free Download
The File Download dialog box will display.

7 If you have Winzip use the following instructions otherwise move to step 8.

a Click on .

b Clickonthe - ofthe button.

of the list. Ensure My Documents is selected then click on Select Folder.

c If My Documents folder is not displayed click on Set default unzip folder at the bottom

be unzipped.

d Clickonthe - ofthe button and click on the My Documents folder. The files will

8 Click on and ensure My Documents folder is displayed. Click on

exercise files.

Click on Open Folder which will display My Documents folder. Right click on the zipped
9 exercise file and select Extract All. Click on Extract. A folder will be created containing the
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Unit Standard 2791 Version 7

Title Integrate spreadsheet and database data into word processed
documents to meet a set brief

Level 2 Credits 3

Purpose People credited with this unit standard are able to integrate
spreadsheet and database data into word processed
documents to meet a set brief.

Classification Computing > Generic Computing

Available grade Achieved

Explanatory notes

1

A brief is defined as a clear description of both the desirable outcomes sought
and the constraints to be met by the solution. It contains requirements against
which the success or otherwise of the document can be evaluated. The brief
can be supplied either as part of the candidate’s employment (in the case of
workplace assessment) or in response to a set task. Text, spreadsheet and
database files will be provided to the candidate.

Range
Evidence is required for two different mail merges, each with a minimum of three
fields of database data being used.

Definition

Presentation means the documents produced must show consistent application
of the principles of page layout, which may include but are not limited to —
composition of elements upon the page, text hierarchy, consistent typography,
balance, harmony, proportion, sequence, contrast repetition, alignment, and
proximity.

An assessment resource to support computing unit standards (levels 1 to 4) can
be found on the NZQA website at http://www.nzqa.govt.nz/for-
providers/resources/index.html.



http://www.nzqa.govt.nz/for-providers/resources/index.html
http://www.nzqa.govt.nz/for-providers/resources/index.html

Outcomes and evidence requirements
Outcome 1

Integrate spreadsheet and database data into word processed documents to meet a
set brief.

Evidence requirements

1.1 Spreadsheet data is inserted into the documents and formatted to meet the
requirements of the brief.

1.2 A spreadsheet graph is inserted into the documents and formatted to meet
the requirements of the brief.

1.3 The word processed documents containing integrated data are mail-
merged using database data to meet the requirements of the brief.

1.4 The mail-merged documents are printed to hardcopy and checked for
readability, legibility, presentation, accuracy and correct mail-merge.



Exercise Files used in this book

(Instructions are at the front of this book for downloading retrievable files from our web site.)

Names of files

Best Deals

John Craig Limited

BluePrint Catalog

Lifestyle Books Budget 2012

BluePrint Clients Data

Lifestyle Books Letterhead

BOF — Gilbert Letter

Lifestyle Books Sales Summary

Book Sales for 2011

Lycra Products Price List

Book Sales for 2011-Chart

Memo Form

Checking Form

Promotion-Data

Clients-Data

Sponsors-Data

Club Meetings

Students Database

Company List — 14 May W2010 Advanced
Course

Students Results Letter

Eats and Treats

Students Results Spreadsheet

Eats and Treats Letter

Toastmasters

Fashion House

VitaHealth Managers

Fax Form

VitaHealth Sales

Fundraising Letter

W2010 Advanced Course — 14 May
Spreadsheet

Jetpoints-Data

Word 2010 Advanced Course Enrolments

Jetpoints-Main




Microsoft Excel Concepts
Microsoft Word and Document Types

1 Integrating Data
Mail Merge

Section

Learning Outcomes

At the end of this section you should be able to -

O  Start Microsoft Excel, understand the Excel screen and spreadsheet concepts

U Start Microsoft Word, understand the Word screen and document types
- Business letters
- Faxes
-  Emall

U Copy spreadsheet data and charts from an Excel workbook to a Word document
0 Understand and use the Office Clipboard
O  Identify mail merge documents and be familiar with merge fields

0 Create a mail merge letter, fax and email

© Cherylprice.co.nz Limited SECTION1 1






What is an Integrated Document?

In most organisations a range of business computer applications or programs are available. Each
application is used to produce an end result, ie Microsoft Word to create documentation, Microsoft
Excel to create spreadsheets, charts, etc.

When working in one application you may need to insert data from another computer application.
Most computer applications available today allow you to do this, giving you the opportunity to
analyse and present all data in one file.

In this workbook you will learn how to create a document and insert data produced from another
computer application. This type of document is called an Integrated Document. An example of an
integrated document is shown below.

MEMORANDUM
TO: Greg Hilton
FROM: Jill Stanway
DATE: 20 August 2012
SUBJECT: Distance Learning Enrolments for Oct-Dec

As requested, enrolment numbers for October to December are shown below in chart -
format. Chart inserted from

spreadsheet file.

Distance Learning

October-December

Number of Students

In the above example a memorandum is typed in Microsoft Word and a chart that has been created
from a Microsoft Excel spreadsheet is copied and pasted into the document.

By using a word processing program together with a data file you can create a personalised letter.
This process is called a “mail merge”. In this workbook you will also learn how to do this.

Combining data from other computer applications allows a user to produce an end result quickly
and easily.

Items can also be copied to the Office Clipboard and pasted (see page 22).

© Cherylprice.co.nz Limited SECTION1 3



Microsoft Excel

Microsoft Excel is a spreadsheet program which is essentially a large working area composed of
rows and columns. The intersection of a row and column is called a cell. Text and numbers are
entered into these cells and formulas are used to manipulate the data to provide information
required.

Microsoft Excel 2010 (or any spreadsheet program) makes calculations easy - it replaces your
pencil, paper and calculator. If you change data in a worksheet, every formula associated with that
data will be automatically recalculated accordingly.

Data can therefore be altered to re-calculate budgets and to forecast results using different sales
projections. Worksheets can be saved on disk, retrieved and printed as required.

Spreadsheets are widely used -

1 Inindustry and commerce for
financial accounts

forecasting and projection results
recording and comparing data
personnel details

2 At home for
e  budgeting
e calculations, eg painting, wallpapering
e savings and travelling expenses

3  Atschools for
e test and examination results
e timetables
e school rolls

4 Atclubs for
e membership fees
e  sports results
e  sponsorship details

Examples of other spreadsheet programs include Lotus 1-2-3, Corel Quattro Pro and
OpenOffice Calc (the last of which can be freely downloaded from the Internet).

Spreadsheet/\Worksheet

The word spreadsheet is a general term for any document created by a spreadsheet program; a
spreadsheet is referred to in Excel 2010 as a worksheet. Both of these terms are used throughout
this book but they refer to the same thing.

4 SECTION 1 © Cherylprice.co.nz Limited



Samples of Spreadsheets

A B C D E F G H
1 Day Trippers
2
3 |Tours January February  March April May June Total
4 Hinterland Tour 256 353 178 125 374
5 The Coast Tour 312 262 285 310 345
6 Bryon Bay and Tweed Heads 408 478 324 314 423
7 FraserIsland 993 810 826 786 874
& |Brisbane in a Day 554 487 512 456 492
9 Brisbane at Night 452 435 478 398 416
10 Total 2975 2825 2603 2389 2924 2860 16576
A B C D £ F
1 VitaHealth Products - Worldwide Sales
2 2011
3 Sales % by Country
a [ @ a3 Qa Total
5 Australia 105,000 95600 87,500 160,200 448,300
6 |Brazil 85,000 92,300 75000 95,000 348,300
7 |United States 199,000 357,000 224,785 391,255 1,172,040 B Australi
8 UnitedKingdom 153,000 169,000 158,700 180,250 660,350 ustralia
9 China 62,500 52,500 49,000 82,000 246,000 ™ Brazil
10 |South Africa 75000 84,000 70,400 96,100 325,500 B United States
1
12 Total 679,500 850,400 665,385 1,005,805 3,201,090 ¥ United Kingdom
13 H China
14 )
M South Africa
15 2010
16
17 a1 a2 a3 [ Total
18 |Australia 55,000 83,000 76,000 155,350 374,350
19 Brazil 75000 85300 72400 95000 327,700
20 |United States 155,000 225,000 123,950 250,780 754,730
21 United Kingdom 125,000 255690 155890 175500 712,080
22 China 65000 45,650 45000 75000 230,650
;3‘ South Africa 78,000 A B | -C | D E E G
25 Total 553,000 1 Te Kea Trading Company
i: 2 Pricing Structure for December Sale
28 | 2009 3
29 4
& - m Cost Retail Quantity Value of Sale
31 Australia 125,000 . R . . .
32 | Brazil 75,000 5 Product Price Price % Margin in Stock Stock Price
33 |United States 185,500 : 6
34 |United Kingdom 145,500 : 7 Calendars $11.00 $18.95 41.95% 50 $550.00 $17.06
35 China 65,000
36 |south Africa 72,500 & Saucepans 75 95 21.05% 25 1,875.00 85.5
37 9 ElectricJug 42 72.5 A4.37% 32 1,344.00 67.95
38 Total 668,500 5 10 Men's Sweatshirt 24 42,95 44,12% 55 1,320.00 38.60
= 11 | Weedeater 185 269.9 31.46% 24 4,440.00 242.91
12 T-Shirts 15 24.85 39.64% 75 1,125.00 22.37
13 |Garden Shed 2595 375.5 21.44% 11 3,245.00 337.95
14| Crockpot 120 159.9 24.95% 30 3,600.00 143.91

ac

Advantages of Spreadsheets
e  Calculations can be performed quickly and easily.
e If data is altered, the calculations automatically adjust.

e Worksheets within a workbook can be used for different groups of data. Data from a group of
worksheets can be calculated onto one summary worksheet.

e  Charts can be used to visually display data, eg bar, column, pie, line.

e Data can be manipulated, grouped and sorted into a specific order for lists, databases, etc.
Data within a spreadsheet can then be quickly located.

© Cherylprice.co.nz Limited SECTION1 5



Starting Excel 2010

Exercise 1

1 Click on the Start button at the bottom left-hand corner of the screen.
‘ » Al Programs

2  Select from the Start Menu.

3 Select ' Microsoft Office from the Programs menu.

4 Select [X] Microsoft Excel 2010 from the list to start Excel 2010.

The Excel Screen

Restore Down

Quick Access Toolbar Tabs Title Bar Minimize —\ [ o
/_ / / — Close
\ Microsoft
N Excel Help
ame
Box N T Ribbon

\ \\ Column heading
Active cell

Formula Bar

Row  ___
heading

Vertical
\ scroll bar
it Horizontal
Status Bar scroll bar
Note | The Office button in Excel 2007 has been replaced with a File tab which

contains all basic tasks such as opening, saving and printing a spreadsheet.

6 SECTION1 © Cherylprice.co.nz Limited



Quick Access Toolbar

The Quick Access Toolbar contains commands to Save, Undo and Redo.
Frequently used commands can be added to this toolbar.

The Ribbon

The toolbars and menus from Excel 2003 were replaced by the ribbon in Excel 2007 and is very
similar in Excel 2010. The ribbon provides access to all the tools required for working with a
spreadsheet.

Ribbon Tabs

The ribbon has a series of tabs along the top; click on the tab to display the ribbon required. There
are seven default tabs:

There are also hidden tabs that appear when appropriate, such as the Chart Tools. These are
displayed when you are working ona chart and disappear again when you have finished.

Groups

Ribbons are split into groups, (eg the Font Group). Each group contains command buttons
appropriate to a particular action; the font formatting tools are located in the Font Group.

B S N 0 I

%
Clipboard Font Alignment Number Styles Cells Editing
Group Group Group Group Group Group Group

© Cherylprice.co.nz Limited SECTION1 7



Dialog Box Launcher

The Dialog Box Launcher is the small diagonal arrow in the bottom right corner of some groups.
When you click on this button, it displays an associated dialog box.

Dialog boxes usually contain more settings or advanced features. For example, the Number
dialog box allows you to make formatting changes to the contents of the current cell.

Number

Key Tips

The keyboard can be used to select tabs on the Ribbon and buttons on the Quick Access Toolbar.
If you press Alt, Key Tips become active.

These small badges are labelled with various letters and numbers, that when pressed on the
keyboard, will trigger the associated command or function. For example, to save the workbook
press Alt and then 1.

ScreenTips

When you rest the mouse pointer over a button or command,
a screen tip appears. This is a small window describing the
function of that command and any shortcut key it may have.

8 SECTION1 © Cherylprice.co.nz Limited



Ctrl O

Opening a Workbook

Exercise 2

1

2

6

© Cherylprice.co.nz Limited

Click on the tab at the far left of the Ribbon. When you click on the File tab
Backstage view will appear. This view allows you to create, open, print and save a
workbook. Excel options, accessing help along with exiting Excel are available in this view.

Click on [ ©pen to display the Open dialog box.

Double click on the 2791 V7 Exercise Files folder, ie |« 2791 V7 Exercise Files

Select Fashion House. Click on .

The spreadsheet is made up of rows and columns as shown below. The intersection of a row
and a column is referred to as a “cell”.

Click on cell A9, ie the cell that displays Total. You will notice that the cell reference is
displayed in the Name box at the top of the worksheet area

Name box Columns
\ A9 - £ | Total 74 B
A B c [0 ¢ F T
[1 The Fashion House - Conference Budget
2
3 Australia  America Britain
4 AirFares 897.00  1,586.95  2,425.28
5 Accommodation 1,200.00 1,800.50 2,000.00
& Meals 950.00  1,060.96  1,250.25
Rows 7 CarRental 660.50 501.23 680.25
& Travel Insurance £0.00 100.00 95.00
5 [Total | $3,787.500 $5,049.64 $6,450.78
10
11
12| 250000
13
14| 200000 J( ' 7
15 p
16 1,500.00 |
17 100000 B Australia
18 B America
13 2000 Britain
20
71 D00 - T
22 k-rﬁ'é: ,b-'e"{\
\24 ey
|

Selecting Worksheet Data

A row can be selected by click on the row header (ie the row number) and a column can be
selected by clicking on the column header (ie the column letter).

To select data in the worksheet you can simply drag across the columns and down the rows, ie
from the beginning cell to the end cell required. This is referred to as a “range”.

Practise selecting columns, rows and various ranges in the worksheet on screen.

SECTION1 9



10

11

12

13

14

10

A chart has been displayed on this worksheet using the spreadsheet data.

To select a chart that is on the same sheet as worksheet data

Click on a blank white area of the chart. If you are unsure if you
have selected the chart correctly click on the Layout tab and ensure
Chart Area is displayed in the Current Selection group as shown
above at the right.

Practise selecting the chart and drag to move it up to the right of the worksheet data.
A chart can be displayed either on the same worksheet as the spreadsheet data.
Click on the Sheet tab at the bottom of the window that displays Pie Chart, ie

| Pie chart | Sheetl “Sheet2 , Sheet3

The pie chart shown below is displayed.

To select a chart that is on another sheet

Click at the right of the heading. If you are unsure if you have
selected the chart correctly click on the Layout tab and ensure

Chart Area is displayed in the Current Selection group as shown
at the right.

Select the pie chart, click on the Home tab and click on =2 €opy ~  in the Clipboard group.
This will copy the chart to the Clipboard.

Click on the Sheet 1 tab then click in a cell under the worksheet data and chart.

Click on . The chart will be displayed under the worksheet data but needs to be reduced
in size.

Move the mouse pointer to the top right corner until the cursor displays as a diagonal arrow.
Drag towards the centre of the chart until it is an appropriate size. You may need to move the
chart to display it attractively under the worksheet data (by dragging on an outside line).

Click on the tab then select &4 Exit  Click on M.

SECTION 1 © Cherylprice.co.nz Limited



Microsoft Word

Microsoft Word is a word processing program that allows you to create text and/or graphics using
a keyboard which is displayed on screen (referred to as “soft copy). The document is then saved
onto the hard disk in your computer system. A document can be opened on screen and edited and
formatted (as many times as necessary). A “hard copy” can be produced by sending the document
to the printer.

A word processing program generally includes the creation of -

e  General correspondence, eg letters, memos, faxes

e Reports, travel documents, minutes of meetings, financial documents
e  Advertisements, flyers, brochures

e  Mail merges (ie direct mail), labels, tables

e  Manuals, other documentation

Data from other programs, eg Microsoft Excel, Microsoft Access etc can be copied into a Word
document, or linked.

The Process of a Word Processed Document

Monitor

System Unit

Mouse Keyboard Speakers
Text is copied from paper .
(or keyed in directly via the —_— Text is displayed on monitor —_— Docagﬁjnltjlizsﬁlvseigeotnhtg the
keyboard onto the (soft copy)

computer monitor) System Unit

Document is printed Document is opened on screen. It can Final copy is printed
(hard copy) then be edited and formatted, saved (hard copy)
and resaved as many times
as necessary.

© Cherylprice.co.nz Limited SECTION1 11
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Starting Microsoft Word

Exercise 3
1 Click on the Start button at the bottom left-hand corner of the screen.
2 Select|” AFrosrms from the Start Menu.

3 Select '+ Microsoft Office from the Programs menu.

Microsoft Word
2010 appears on
the Start menu after
you have used it
three times. You
canclickonitto
start Word.

4 Select [W] Microsoft Word 2010 from the list to start Word 2010,

Microsoft Word will be displayed on screen with a new document, ready for you to enter text.

Quick Access Toolbar Tabs Title Bar Minimize Restore Down

__ Close

File tab — Help

} Ribbon

G View
roup Ruler

Insertion point Vertical
Scroll Box

\ Vertical

Scroll Bar
Note:

If Rulers are not displayed click

on the View Ruler button E;l at
the top of the Vertical Scroll Bar.

Select
Browse
Object

;’—/ ﬁ_/ D
Status Bar Document Views Zoom Controls

Parts of the Word screen, ie tabs, ribbons and groups are similar in Word as they are in Excel (see
pages 6 and 7).

12 SEeECTION1 © Cherylprice.co.nz Limited
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